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New Feature for Employee Events 
You may have noticed that we recently added a new feature to Pro Fund Accounting 
for managing and tracking Employee Events. This feature was designed to inform you 
when certain events are approaching for your active employees.  
 
The Employee Events feature is enabled whenever you are logged in with Payroll 
rights. You will see a number of events displayed on the status bar on the bottom right 
side of your main screen in Pro Fund Accounting. This is the total number of events 
occurring within the next month for all your active employees. This number is retrieved 
automatically from a list of event dates you have saved for each of your employees. 

 
We have included a wide range of events for you to manage for each of your employ-
ees. These events include items such as insurance renewals, license renewals, per-
formance reviews and many others. For a complete list of these events, please see 
the new Events page in the Employee Maintenance form. Here, you will find a list of 
these events with dates you can enter individually for each employee. There is even a 
Misc Event and Misc Note that you can enter for special events that are not already 
included in the list. You can save dates for any events you wish to manage. Pro Fund 
Accounting will keep an eye on these dates for you and let you know when they are 
approaching. 

You can view a list of the upcoming events by clicking the “View Current Active Employee Event Items” menu item locat-
ed under the Payroll Menu from the main screen. This will open a list of events occurring within the next month for all 
you active employees. You can filter that list by checking only the events you wish to include in your list. Your filter selec-
tions are retained each time you open the list but will not affect the total upcoming employee event count displayed on 
the main screen. 
 
Finally, if you need more control over this list, you can run the new PR Event List re-
port which is located in the Payroll section of your report selection screen. This report 
offers several additional parameters you can specify for even more control over the 
events you wish to list. You can even specify a date range to list events occurring 
within any time frame. 
 
We would like to thank you for your requests and suggestions for adding this new fea-
ture and are pleased to incorporate it into Pro Fund Accounting. We hope you find it 
helpful for managing and tracking your Employee Events.  Spread the Word! 

 
If you know of a Township, 
Village or City that's looking 
for new accounting or utility 
billing software, please  
recommend us! 
 
You can refer them to our 
websites at: 
 
www.profundaccounting.com 
and/or www.utilability.com. 
 
They can ask for further 
information and request a 
quote or demonstration  from 
either Steve Ferguson (ext. 
6) or George Loescher (ext. 
9) at (866) 634-9991. 
 
Thanks! 

Equipment Questionnaire and the Equipment Profit and Loss 
In the beginning there was the Equipment P&L. Mandated by the Highway Depart-
ment, it was used to help calculate the rental rates for each type of equipment for the 
following year. 
 
When all the P&L reports were in, the State could calculate the equipment rental rate 
for each type of equipment. That rate is meant to balance the expenses for each type 
of equipment. The rate gives the road commissions the optimal charge out rate to pro-
jects when the equipment is used. 
 
Simple. And there was just a small list of required data to pull this together: the cost of 
operating stock, the indirect costs via a percentage spread, the depreciation, the 
hours used, and the earnings for the year. The reports would also show the profit or 
loss: the earnings minus all the expenses. 
 
Once a year the Highway Department would gather all this together for all the Road 
Commissions and calculate new rates for the next year. This was all done manually in 
the beginning and later with the assistance of computers. But even so it was a big job 
with all the Road Commissions reporting on their entire fleet of equipment. 
 

http://www.profundaccounting.com
http://www.utilability.com
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9G BACKUP™ online data 
storage software is the 
fastest backup software in 
the market. Advanced 
mathematical technologies 
have made it possible to 
backup huge amounts of 
data in the least possible 
time. 
 
The 9G BACKUP™ data 
storage software doesn’t slow 
down your computer when it’s 
working or when it's "sleeping." 
 
Sign up now for a no hassle 
30-day free trial at: 

 
www.9gbackup.com 

Equipment Questionnaire and the Equipment Profit and Loss  
(continued) 
On the Road Commission side, Cogitate provided a report: the Equipment P&L to gather all this information into a report. 
Originally this report existed before Cogitate implemented the Fixed Asset programs to calculate depreciation. Since the 
equipment’s depreciation was part of the required information the report had to calculate it on the fly. That was no prob-
lem when the early reports were programmed just like a maintenance screen might be but when we switched to a report 
generator like Crystal Reports the depreciation calculation was beyond its capabilities. 
 
To use the report generator for the Equipment P&L we needed the Fixed Asset programs to be up and running. When 
that was done we made a new report Equipment P&L using FA. We still had the original report for users who hadn’t yet 
implemented all their Fixed Assets but it was subject to the limitations of the report generator and left a lot to be desired. 
Since everyone now has Fixed Assets running the original Equipment P&L has been removed from the system. 
 
Meanwhile the state still needed to automate the whole process of getting the P&L reports from all the Road Commis-
sions in order to calculate the next year’s rental rates. The Equipment Questionnaire was born. Initially this was just a 
specification of a report layout that could be put in spread sheet form and the State could receive a file instead of the 
printed P&L. Later a data file format was specified that the State could import into a program of their own and automate 
the whole process. 
 
To support this, Cogitate implemented the Equipment Questionnaire program in 2007. It gathered all the data from ex-
penses, fixed assets, and usage and updated a special table meant to hold this information. From that table the Equip-
ment Questionnaire report and the data file for the state are produced. 
 
The Equipment Questionnaire system has worked very well for the State and our Road Commissions and so we made a 
new Equipment P&L from Calculation report to use the results from the Questionnaire calculation to produce a P&L re-
port that would exactly match the Questionnaire. 

Pro Fund Accounting Tip of the Month 
Anytime you’re posting in GLPOST, you can print the journal you’ve posted to by 
clicking on the PRINT JOURNAL button before you COMMIT. This will load the 
journal you are working on so that you can print it and then afterward COMMIT it. 

And that’s where we sit as of 2012. Two Equipment P&L reports: one from Fixed Assets and one from the Questionnaire 

and then the Questionnaire calculation that produces both a report and a data file for the state. 

Fiscal Year-End Procedures for Pro Fund Accounting 
Since all postings are done by effective date, you have a couple of options at year 
end. 
 
Option 1: Run the Post Balances Forward program on the last day of your fiscal 
year. This will close all of your Expense and Revenue accounts to your Fund Bal-
ance, and give you starting balances for your new fiscal year. This is usually done if 
you are not due for an audit, or, if your audit is going to be delayed by a couple of 
months.  
 
If you do have an audit, and receive adjustments, you will have to delete the Clos-
ing Entries and Balance Forward Entries journals before posting your adjustments.  
 
To do this, go to General Ledger, GL Constant Maintenance, Settings. Click on Edit 
and change the Fiscal Year Start Date to the prior year, and save and done.  
 

Next, go to GLPOST, change the SOE to BF, click on the folder button (next to Journal Number), and double-click on 
the top journal. This should load the last BF journal. If the Effective Date is the first day of your current fiscal year click 
on Delete All. Next go to GLPOST, change the SOE to CE and repeat the steps above. You can now post your audit 
adjustments, using an Effective Date of the last day of your old fiscal year.  

http://www.9gbackup.com
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FISCAL YEAR-END PROCEEDURES for Pro Fund Accounting 
(continued) 
Rerun the Post Balances Forward program, and continue on with your postings. 

 
Option 2: Continue posting into the new year. After you receive and post your audit adjustments, run the Post Balances 
Forward program, and you will have new beginning balances. Just remember that until you run the Post Balances For-
ward program, you will not have current year to date balances on your reports. 

Bar Code Scanner 
 
Cogitate's Bar Code Scanner 
is ideal for taking physical in-
ventories or receiving stock. 
Just scan the bar code label 
on the inventory item, and the 
Bar Code Scanner does the 
rest. From posting inventory 
information to printing bar 
code labels, this tool is invalu-
able! 
 
For further information on our 
Bar Code Scanner, please 
contact Brett Brouwer at (866) 
634-9991, ext. 5. 

Attention Barcode Scanner Customers 
Scanner Support Application Update 
There is a new version of the Scanner Support application that contains an updated 
Physical Inventory Adjustments function. This update allows the scanned adjustment 
entries you save to be edited later, using the Inventory Post function within Pro Fund 
Accounting. Previous versions did not allow this and would incorrectly update your 
journals if you tried to do so. 
 
Please note: This update is not retroactive, so you still need to avoid editing any 
Physical Inventory Adjustment Journals that were created with previous versions of 
the Scanner Support application and Physical Inventory Adjustments function. 
 
Cogitate Scan Application Update 
There will be a new version of the Cogitate Scan application available soon. This is 
the application located on your barcode scanner. This update will allow Cogitate Scan 
to properly identify the type of item you are scanning for multi type entries, even if 
there are other types using the same code. For example, if you have a work order 
and equipment code that use the same number, you can scan either one and the pro-
gram will recognize the type of item you are scanning. If you are entering these man-
ually, you will be able to specify the type of item that you are entering if there is more 
than one type using that same code. This is important so the information can be 
saved correctly when scanning or entering multi type entries such as the Account/
Equipment/W.O. Number field within the Inventory Charges function. 
 
Important Note 
Both updates listed above will be retrieved when you check for updates; however, 

they need to be copied to their correct locations to complete the update correctly. 

Please contact the Cogitate support staff for help installing these updates correctly. 

Capturing Screen Shots and Attaching them to Emails 

There are times when you need support and it would help you to explain the problem if you could show a picture of what 
you mean. Capturing screen shots and attaching them to an email is the easiest way to do this. But how do you do that? 
 
In Windows XP and Windows 7: To capture a copy of an open window, hold down the ALT key and press the PrtScn key 
on your keyboard. This action copies the active window. To save the screen shot, open Paint (under Start/All Programs/
Accessories). Under the Edit menu, select Paste to paste your screen shot into the Paint window, or simply hold down 
the CTRL key and press the letter "V". To save the screen shot, hold down the CTRL key and press the letter "S". Give 
the screen a title and select a file type for the picture format. Use .BMP, .JPG, .GIF, or .PNG. You can use your saved 
screen shots in Power Point presentations, word processing documents, and as attachments to emails. 
 
Windows 7 Snipping Tool: Windows 7's Snipping Tool lets you select what part of the screen you want to capture (full-
screen, a selected region of the screen/window, or window only), and then gives you the opportunity to save the screen 
shot. This is a nice little tool that will save you some of the steps described above. Before running the Snipping Tool, 
make sure you're running the program whose screen you want to capture. 
 
To use the Snipping Tool, click the start button. Type Snipping (you don't have to type the whole name) and the program 
name will appear at the top of the window that opens under the Programs (x) heading. Click it to select it. 
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Cogitate has partnered with 
Bill Flash. Bill Flash is a 
company that will print your 
UtilAbility invoices and mail 
them for you, for a low per-
piece price. This price includes 
the cost of producing the bills, 
stuffing them for mailing, and 
the cost of postage. 
 
For further information about 
Bill Flash, please contact Brett 
Brouwer at (866) 634-9991, 
ext. 5. 

Capturing Screen Shots and Attaching them to Emails 
(continued) 
Click the NEW drop-down arrow and select Window. Under the NEW drop-down arrow you're asked to select the window 
you want to capture. Click on the window you want a screen shot of. That's it! Your screen shot will be displayed in a new 
window. To save the screen shot, under the File menu, click on "Save As" (or hold down the CTRL key and press "S"), 
and where the default picture name is displayed, type in the name you want to use. Don't forget to select the type you 
want to use. Notice that your screen shots will be saved under "Libraries/Pictures." You can use your saved Snipping 
Tool screen shots in Power Point presentations, word processing documents, and as attachments to emails. 

UtilAbility Tip of the Month 
Our tip this month is to please remember to keep your UtilAbility software up to date by 
checking for updates frequently.  
 
When you check for updates, UtilAbility will compare your UtilAbility related software to 
the latest available on our web site and update any files necessary to stay current. This 
includes your database, application, reports and other files related to or used by UtilA-
bility. It’s important to keep UtilAbility up to date to ensure you have the latest enhance-
ments and features. 
 
Checking for Updates is easy and you can do it as often as you wish. You simply click 
the Check for Updates menu item located under the Help Menu and follow the instruc-
tions to check for and complete your update. 

 
You can check for updates from any computer running UtilAbility, even if you are on a 
network. If you use UtilAbility on more than one computer, please make sure no one 
else is running UtilAbility while you perform the update. This ensures no files are 

locked by another user, which may prevent them from being updated.  
 
If your database has already been updated, other computers on your network may let you know that they need to be 
updated as well, upon logging into UtilAbility. However, to be absolutely sure they are up to date, it is always best to 
check for updates on all computers that have UtilAbility installed on them. If any computer is already up to date, the 
check for updates utility will let you know. There is no harm in checking, even when you already have the latest updates.  
 

If you have any questions about checking for updates or about your UtilAbility installation, please contact the Cogitate 

support staff for more information. 

 
New 9G BACKUP™ Website Design 

Cogitate just unveiled the new 9G BACKUP™ 
website. We urge you all to take a peek and 
give us your feedback.  

 

In future website updates, we’ll be adding “how-to” videos, a more extensive FAQ page, customer testimonials, and a 
blog spot to which you can contribute. 
 
We’re very proud of our 9G BACKUP™ online data storage software, and we hope those of you who’ve not yet taken 
advantage of the speed and ease of backing up your data will join those who have! We think you’ll also be surprised at 
just how little peace of mind can cost. 
 
We’re giving the big dogs a run for their money and we hope you will all share with us in this endeavor! 

 
 

http://www.9gbackup.com 

http://www.9gbackup.com
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Skipping a Generation 
We humans are an amazing bunch and I’m always interested in how we got to be who 
we are. 
 
In some recent readings I learned that early humans had and we still have an unex-
pected capability that helped us survive evolution’s winnowing process. We can outrun 
any animal. That seems surprising since many animals are faster than we are but our 
unique capability is to outlast any animal in a run. So while a cheetah is much faster 
than any human, a human can eventually run down and catch a cheetah for a meal. 
 
The reason that we can do this is that other animals overheat with exertion and have to 
stop to cool down. At least two factors contribute to this capability: we are upright and 
we are without fur. Being upright means we present less surface area to the sun and 

so absorb less heat. A horse at noon absorbs much more sunlight and heat than does a standing or running man. Being 
upright also allows our hands to use weapons to dispatch our prey. Being without fur allows sweat to evaporate and cool 
our bodies. Humans are the world-class long distance runners. 
 
Evolution needs diversity to work and humans and probably most other species have some tricks up their genes to pro-
mote diversity. It is commonly understood that a child is a product of the mother and father. The genes of each are mixed 
up and so the child is a combination of both. But that is not exactly correct. Each parent produces genes from his or her 
two parents. It is those four sets of genes from the grandparents that are combined to make a baby. 
That means that to see a child’s heritage it is best to look not at the two parents but at the four grandparents. It is their 
characteristics that form the genetic base for the child. 
 
There is an old adage that some characteristics “skip a generation.” It is a commonplace and often heard reason for 
height or hair color not matching the parents but matching one of the grandparents. And since the child is the result of 
selected genes from the four grandparents, it is easy to see the hereditary reason for this. 
 

Hmm… My mother and father were both exceptionably intelligent. That says something about me but I don’t want to 

think about it right now. 

Have questions about what 
you read this month in our 
newsletter?  
 
Want more information 
about our products or  
services? 
 
Visit our website: 
www.cogitateinc.com 
 
Contact Us:  
Phone:  1-866-634-9991 
Fax: 1-989-649-5900 
Presdent@CogitateInc.com 

If you do not wish to  
receive these  

Newsletters please visit: 
 

www.cogitateinc.com/news.html 

http://www.cogitateinc.com
mailto:president@cogitateinc.com?subject=NewsLetter%20Comments
http://www.cogitateinc.com/news.html

